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GroupWise 6.5 Main Screen 
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Default GroupWise Folders 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mailbox 
� Contains the incoming messages you receive (your “in 

box”) 

� Double-click on any message to open it (or click once 
then press enter) 

 
Sent Items 

� Stores copies of messages you have sent 

� In the Sent Items folder you can… 
� View status of messages you have sent 
� Resend messages 
� Retract messages (if recipient has not opened) 

 
Calendar 

� Click once here to view your calendar 
 
Contacts 

� Lists everyone in your Frequent Contacts address book 
 
Documents 

� We won’t cover this! 
 
Checklist 

� Electronic “to-do” list 
 
Work in Progress 

� Keeps drafts of unsent messages until you are ready to 
send them 

 
Cabinet 

� You can create folders and store messages here 
(organize your messages) 

 
Trash 

� Contains items you delete  

� You can retrieve items from the trash can, but items 120 
days old are automatically purged 
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Default GroupWise Tool Bar 
 

 
 

Think of the tool bar as being divided into 3 sections: 
 
 
 

 
Miscellaneous tools 

 

  
Viewing tools 

 

 
Address book 

 

 
View details 

 
Properties 

 

 
View discussion threads 

 
Print Calendar 

 

 
View as calendar 

 
Find 

 
 

Quick viewer 

 
 
 

 
Tools for creating and sending messages 

 

 

Email 

Send a message to someone (or send a “Posted Message” to 
yourself) 
 

 

Schedule a meeting or appointment 

Ask someone to have a meeting with you (or post an appointment to 
your own calendar). 

Appointments are just like email messages, but you specify a time, 
date, place, and duration.  If the receiver accepts, it updates his/her 
calendar and yours. 
 

 

Create a New Task 

Ask someone to do something for you (or assign a task to yourself). 

Like an email message, but it specifies a start date, due date, and 
priority.  If receiver accepts task, it is added to their task list on their 
calendar. 
 

 

Create New Document 

We cannot do this. 
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Types of GroupWise Messages 
 

To create a new message: 
� Use the toolbar icons, OR 
� Go to the File menu / New 

 
 
Mail 
 “Regular” email message * 
 Simple message 
 Posted message 
 
Appointments 
 Meeting * 
 Posted Appointment 
 
Tasks 
 Task * 
 Posted task 
 
Reminder Note 
 Reminder * 
 Posted reminder 
 
Discussion / Note 
 
Phone Message 
 
Checklist Item 
  

 

NOTE: 
 
In GroupWise, the word posted 
refers to a message (or appointment 
or task, etc.) that you send to 
yourself. 
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Mailbox How To’s 
 
Send an email message 

1. Click the New Mail toolbar button. 
2. Address the message  

� If the recipient is in your GW address book, you can type his/her name, allowing 
auto-complete finish the typing.  (Or click on the Address button and select the 
person there.) 

� If the recipient is not in the address book, type his/her email address.   
Press Enter to continue adding more recipients.  Press Tab to go to the next 
field if there are no more recipients. 

3. Optional -- Complete the CC: (carbon copy) and BC: (blind copy) fields. 
4. In the subject field, type a brief, meaningful message. 
5. Type your message in the message field. 
6. Click the Send button.  

 

Spell check 
After writing your message, but before sending it, choose Tools / Spell Check.  
NEW!  Your subject line will be checked for spelling errors. 
 

You can automate spell checking to happen every time you send a message by 
choosing Tools / Options / Environment / General tab and selecting “Check 
spelling before send”. 

 

Attach files 
1. Start a new message as described above. 
2. Before sending, click on the Attach button. 
3. Navigate through the folders on your computer to select the file you want to attach.   
4. Click OK.  The attached file appears below the message. 

 

Save a draft 
1. While working on an email message, go to the File menu and choose Save Draft. 
2. Select the Work in Progress folder and click OK. 

 

Resume working on a draft 
1. Click on the Work in Progress folder to view its contents. 
2. Double-click on the message you want to work on. 
3. Finish the message and click Send. 

 

Read a message 
1. Click on the Mailbox to view the list of items you have received. 
2. Double-click the desired message, or highlight the message and press enter. 
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View or open attachments 
NOTE:  The very first time you open an attachment in GroupWise 6.5, you must 
choose how you want GroupWise to open all attachments:  
 

a. by starting the default application, such as Word (answer Yes),  OR 
b. by opening the GroupWise Viewer (answer No).  

 

You can change this setting later by choosing: 
Tools menu / Options / Environment / Default Actions File Attachments: Open 
Attachment / Open in a New Window 
 

1. Open an email message.   
2. Double-click on an attachment (below the body of the message).  This will either 

open the application used to create the document (ex: Word, Excel), or open the 
GroupWise Viewer (which will allow you to save the document locally or open its 
application). 

3. OR Right-click on the attachment and choose to open it, view it, save it, or print it. 
 

Reply to a message 
1. While the message is open, click Reply. 
2. Choose either “Reply to sender” or “Reply to all” (i.e., send reply to all recipients 

and to those on the CC: list). 
3. Click OK. 
4. Type your response. You can type it above the original message or intersperse 

comments in the original message.  If you intersperse your reply with the original 
message, choose another font, style, or color to distinguish your remarks. 
 

Forward a message 
1. Open the message to be forwarded. 
2. Click on the forward button. The forwarded message appears in full text at the 

bottom of the message. 
3. Address the message, and type any comments you want to include. 
4. Click Send. 

 

Delete a message 
1. Highlight the message in your mailbox. 
2. Press the Delete key.  The message is moved to the GW Trash folder.  

 

Retrieve a message from the Trash folder 
1. Click on the Trash folder to open it. 
2. Highlight the message. 
3. Choose Undelete from the Edit menu (or right-click on the message and choose 

Undelete from the pop-up menu).  The message will be restored to its original 
location. 
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Address Book How To’s 
 

The Address Book has been reorganized to display address books in an Address Book 
List in the left pane of the Address Book window. You can expand and collapse each 
address book by clicking +  and  -.  
 
Expand an address book to see any Groups. Click on the address book or group name 
to display information about contacts, resources, organizations, and groups in the right 
pane of the Address Book window 
 
3 Sections of the Address book: 

• “Master” address book -- Lists name, email, phone number, etc. of everyone in 
NCCCS that uses GW.  Only the GW system administrator can make changes 
here.  Public groups established by the system office are here. 

• Personal address book -- You can add contact info for people who are not in 
the “master” address book.  You can also create your own personal groups here. 

• Frequent contacts -- GW maintains a list of people you send messages to most 
often.  When you start typing a name in the “To:” line, GW searches here first. 

 
NEW!  Contacts Folder  
The Contacts folder represents the Frequent Contacts in your address book. Any 
modifications you make in the Contacts folder will also be made in the Frequent 
Contacts address book. From this folder, you can view, create, and modify contacts and 
groups. You can change the folder properties so that Contacts represents a different 
address book: 
 

Right-click on the Contacts folder / choose Properties / choose a different 
address book from the drop down list 

 
Comments Tab 
Keep track of notes about a specific contact by writing a comment. Double click the 
contact to open the contact’s info and click on the Comments tab. Insert a Timestamp to 
document the date and time before adding a comment.  
 
History Tab 
Click on the History tab to search for all items sent or received from the contact. 
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Add someone to your personal address book: 
1. Open the Address Book. 
2. Click the address book with your name on it to view your personal address book. 
3. Click the New button / Choose Contact / Click OK 
4. Fill in the person’s first name, last name, email address, phone number, etc. (You 

can tab between fields.) Record as much or as little info as you like. 
5. Click OK. 

 

Modify an entry in your personal address book: 
1. Open the Address Book and choose your personal address book. 
2. Highlight the contact you want to edit. 
3. Click the Details button. 
4. OR Double-click the contact. 
5. Change any information, and then click OK.  

 

Create your own personal groups:  
NOTE: Groups may be comprised of addresses from the “master” address book, your 

personal address book, or both.  If you want to add people to a group who are 
not in the “master” book, you must first add them to your personal address book. 

1. Open the Address Book. 
2. Choose the address book where you would like to put your group. 
3. Right-click the address book in the left pane. 
4. Choose New Group. 
5. Type the name of the group. 
6. Press enter to accept the changes. 

 

Add Names to the Group 
1. Find the address book where you created the group. 
2. Click on the group name in the left pane. 
3. Choose any address book to find the contact that you want to add to the group. 
4. Drag a name from the right pane to the group in the left pane. 

 

Address a message to a group:  
1. Start a new email message. 
2. In the “To:” field, type the name of a group you created.  (Or, click the Address 

icon, go to your personal address book, double-click on the group name, then click 
OK.) 

 

Modify a group: 
1. Open the Address Book. 
2. Find the group you want to edit. 
3. Double click to open the group, in the right pane. 
4. In the list of group members, highlight a member and Remove.   

Or, add new members. 
5. Click OK to save changes. 
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Sent Items How To’s 
 
Note: Most tracking functions apply to messages sent to other GW users.  You cannot 

retract a message sent to a non-GW address or find out whether it was opened. 
 
Another note:  
The very first time you double-click on an item in your Sent Items folder, you are asked 
to choose a default method of viewing sent items: 

a. view the item’s Properties, OR 
b. open the item (view the original sent item). 

You can change this setting later by choosing Tools menu / Options / Environment / 
Default Actions. 
 
Check the status of a message:  

1. Click the Sent Items folder to open it. 
2. Right click on a sent item and choose Properties to display the item’s tracking 

information. 
 
Retract an unopened message from the recipient’s mailbox:  

1. Open the Sent Items folder. 
2. Highlight the message and press the Delete key. 
3. Select to delete the message from… 

� My Mailbox -- removes from your Sent Items, leaves in recipient’s Mailbox 

� Recipient’s Mailbox -- removes from recipient’s Mailbox, leaves in your Sent 
Items 

� All Mailboxes -- removes from recipient’s Mailbox and from your Sent Items 

4.  Click OK. 
 
Re-send a message: 
Note: If you find an error in a message you already sent, and the recipient has not 

opened it yet, here’s how to make the correction and retract the original. 
1. Open the Sent Items folder. 
2. Right-click the message you want to re-send and choose Resend. 
3. Make changes to the message, click the Send button 
4. Click Yes when you are asked if you want to retract the original item. 
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General How To’s 
 

Set a password:  
1. From the Tools menu, choose Options, then double-click Security. 
2. Enter a password in the New Password field.  Type the same password again in 

the Confirm New Password field.  Choose OK to set the password.  The next time 
you log in to GW you will need to type your password.  Passwords are case 
sensitive. 

3. You will need to set a password in order to use GroupWise WebAccess. 
NOTE:  Please write down your password in a secure location!  However, if you 
forget it, the GW system administrator can clear it. 

 

Add an automatic signature to messages:  
1. From the Tools menu, choose Options, then double-click on Environment.  Click 

the Signature tab. 
2. In the box provided, type the information you want appended to the bottom of your 

outgoing email messages. 
3. Select whether you want your signature automatically added to all messages or if 

you want a prompt before the signature is added.   
4. Click OK. 

 

Customize the toolbar:  
1. Right-click on the toolbar and choose Customize Toolbar... 
2. Click the Customize tab. 
3. Click a category in the list to display a group of toolbar icons.  You can click on any 

icon to see its name and function.  To add a selected button to your toolbar, click 
on Add Button. 

4. To delete an icon from the toolbar, drag it off the toolbar.  You can also rearrange 
toolbar buttons by dragging them around. 

5. When you are finished, click OK. 
 

Organize your email 
You can organize items by moving them from your Mailbox into folders that you create 
in your Cabinet. 
 

To create folders 
1. Click on the Cabinet on the left side of the GroupWise screen.  
2. Choose File / New / Folder. 
3. Click Next to create a personal folder, then give the folder a name.  You can click 

the Up/Down buttons to place the folder where you want it in the Cabinet.   
4. Click Next again. 
5. You will see many options for the folder.  Click Finish to accept the defaults. 
6. Click and drag items from your Mailbox into your folders. 
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New Features 
 

Tabbed Item View 
All Item windows (such as new mail, received messages, appointments, tasks, etc.) 
now use tabs. Click on a tab to make selections and specify additional information 
about that item. 
 
Examples: 
When composing New Mail, the Send Options tab lets you select the send options 
such as Priority, Delayed Delivery, Security, Status Tracking, for that message.  
 
Messages that have been received or sent have a Properties tab shows that allows 
you to see who else received the item, the size and creation date of attached files, 
and more.  
 
The Personalize tab gives you the option of adding a personal subject and 
assigning a category to the item. The original subject of the email displays in the 
message window, your personal subject appears in the details list. 

Filters and Categories:  Finding a message 
 

Filters 
Find an email quickly by accessing the Filter from the message list header.  
 
Choose from theses Filter options: 

• Filter (From, To, CC, Subject, Message, Category) 
• Filter for Received Items 
• Filter for Sent Items 
• Filter for Posted Items 
• Filter for Draft Items 

 
Categories  
Use Categories to filter, color code and organize your email.  
 
Default Categories include:  

• Follow-up 
• Low priority  
• Personal 
• Read Later 
• Urgent 

 
Edit or remove color from a category. Rename or delete a category. Assign a 
category to an email by right-clicking on the email and choosing categories. Choose 
a category from the list. 
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Headers 
 
Headers have been added above the message list, folder fist, calendar, and 
QuickViewer. They have also been added to items such as email and tasks. These 
headers provide information about the folder or view you are in.  
 
Customize Headers 
 
Header Color 

1. Right-click the header that you want to change 
2. Click Header Color 
3. Choose a color and click OK 

 
Header Text Color 
1. Right-click the header 
2. Click Header Text Color 
3. Choose a color and click OK 

 
Header Font Size 
1. Right-click the header 
2. Click Header Font Size 
3. Click a font size 

 

Using Help 
As always, GroupWise has a great Help menu. To access the Help Topics:  

Go to Help / Help Topics 
 
New Icons 
Using the Help menu, you can access a list of new icons that appear next to items in 
your Mailbox and Calendar. These icons show information about items like: email 
has been replied to, email has been forwarded, email has been sent, etc.  

Perform an Index search on “icons” then choose About the Icons 
Appearing Next to Your Items 
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Junk Mail Handling 
Use Junk Mail Handling to decide what to do with unwanted email that is sent to 
your GroupWise email address. Junk Mail Handling does not apply to email from a 
sender that is part of your GroupWise system. 

 
Junk Mail Handling allows you to: 

• Modify Junk Mail Handling lists and settings 
• Block or junk email from a user 
• Junk email from users not in a personal address book (not 

recommended) 
• Automatically delete items from the Junk Mail folder 

 
To send an email to a Junk Mail list: 
Right-click on the email and choose: 

• Trust sender… 
• Junk sender… 
• Block sender… 
• Choose Junk Mail Handling to change your settings or view contents of a 

list 
 

 

Enable Junk List 
Creates a Junk Mail 
folder in your folder list. 
You control what email 
addresses are on the 
Junk List. 

Automatically move items 
from the Junk Mail folder 
to the Trash. Default is 14 
days. 

Block email from 
addresses that you 
place on the Block List.  
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GroupWise WebAccess http://mail.durhamtech.edu:82/ 

 
GroupWise WebAccess enables you to access your GroupWise mailbox through a Web 
browser when you are away from your office.  With WebAccess you can check your 
mail, send messages, check your calendar -- almost all of the things that you can do 
through GroupWise in your office.  However, the web interface looks and acts a bit 
differently than the GroupWise program in your office. 
 
Important notes:  
� You must have access to the World Wide Web to get to it 
� You must have a password set up in order to use WebAccess.   

(To set up password:  On your office computer, open GroupWise.  From the Tools 
menu, choose Options.  Double-click on Security.  Enter password 2 times and click 
OK.  Click OK again to exit Options.) 

 
 
Here’s how to check your GroupWise email on the Web: 
 

1. Go to the GroupWise WebAccess address: http://mail.durhamtech.edu:82/ 
 

You will see this option: 

 
 

2. The WebAccess login page appears: 
 

� For name, you can enter your user ID (ex: mcphaulk) or your name as it appears 
in the GroupWise address book (ex: Karen McPhaul) 

� A password is required. 
 
 

 
 
 

3. Your mailbox information is displayed: 
 

Enter your GroupWise user ID, your 
password, and click the LOGIN button. 

click Go 
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Tips for using GroupWise WebAccess: 
 
• Click any message to view it and read it.  There will be buttons across the top of the 

opened message allowing you to close it, delete it, reply, forward, etc. 

• To compose a new message, just click on the Compose button in the tool bar area.  
Address your message, compose it, and click the “Send” button. 

 

Address Book Tips: 

• When addressing a new message, there is no “auto-complete” feature as in regular 
GroupWise.  You must type the person’s name exactly as it is listed in the 
GroupWise address book or type their user ID.  Or, you can click on the Address 
Book button to look up the person. 

• The WebAccess address book is a bit different from the regular one.  Use the drop 
down menu boxes to choose options for finding names. For example: the default is: 
last name, begins with. You can type one letter or a few letters of the person’s last 
name to narrow the search. Click the “Search Address Book” button to start the 
search. 

• When you find the person you want in the Address Book, click on the “To” button (or 
the “CC or “BC” buttons) to address the message. Then, click the Mail button to 
begin composing the message. 
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